
CHÖÔNG XI. 
LAØM VIEÄC VÔÙI CÖÛA SOÅ TRÌNH BAØY 

Khi ñaõ coù caùc lôùp baûn ñoà soá hoaù, ngoaøi vieäc thöïc hieän nhöõng phaân tích vaø tìm kieám
treân caùc lôùp baûn ñoà soá, nhieàu khi ta cuõng caàn phaûi trình baøy baûn ñoà ñeå in aán hoaëc
hoaëc chuyeån thaønh moät taäp tin aûnh chaúng haïn. Baûn ñoà ñöôïc ñöa vaøo moät cöûa soå ñöôïc
goïi laø Layout Window (Cöûa soå Trình baøy). Cöûa soå naøy khoâng nhöõng trình baøy ñöôïc
cöûa soå baûn ñoà maø noù coøn hieån thò ñöôïc taát caû nhöõng cöûa soå khaùc coù trong MapInfo ví
duï nhö cöûa soå bieåu ñoà/ñoà thò, cöûa soå döõ lieäu, cöûa soå chuù giaûi,... Trong Chöông VIII
chuùng ta ñaõ xem xeùt caùch trình baøy moät baûn ñoà thoâng qua moät ví duï. Chöông naøy seõ
baøn luaän chi tieát hôn veà cöûa soå trình baøy.

Löu yù raèng trong chöông naøy, ñoái vôùi caùc phaàn lieân quan ñeán ñònh daïng trang trình
baøy, maùy tính phaûi ñöôïc caøi ñaët ít nhaát moät maùy in, neáu khoâng caùc ñònh daïng trang
trình baøy cuõng nhö vò trí teân baûn ñoà vaø moät soá yeáu toá khaùc ñöôïc ñöa vaøo trang trình
baøy coù theå seõ khoâng ñuùng khi löu laïi trong workspace vaø môû ra laàn sau.

XI.1. TOÅNG QUAÙT

XI.1.1. Hoäp thoaïi New Layout Window

Vieäc taïo cöûa soå Layout ñöôïc thöïc hieän qua leänh Window > New Layout Window töø
menu chính. Khi choïn leänh naøy hoäp thoaïi New Layout Window seõ môû ra (hình XI.1).
Hoäp thoaïi naøy coù 3 tuyø choïn:

- One Frame for Window: môû cöûa soå Trình baøy coù moät khung cho moät cöûa soå maëc
ñònh. Ñaây laø tuyø choïn maëc ñònh vaø trong oâ beân phaûi seõ coù teân cöûa soå ñang ñöôïc
kích hoaït.

- Frames for All Currently
Open Windows: Môû
cöûa soå trình baøy vôùi taát
caû caùc cöûa soå ñang
ñöôïc môû, moãi cöûa soå
ñöôïc ñaët trong moät
khung.

- No Frame: Môû cöûa soå
trình baøy nhöng khoâng
coù khung naøo. Hình XI.1. Hoäp thoaïi New Layout Window -

Taïo cöûa soå trình baøy môùi.
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Khung (Frame) laø khaùi nieäm ñöôïc söû duïng trong cöûa soå Trình baøy, moãi noäi dung
töø moät cöûa soå naøo ñoù khi ñöôïc hieån thò trong cöûa soå Trình baøy seõ naèm trong moät
khung.

XI.1.2. Cöûa soå Layout

Giaû söû ta môû lôùp baûn ñoà cac_tinh ra roài choïn leänh naøy, vì chæ coù moät cöûa soå ñang
môû treân tuyø choïn maëc ñònh seõ hieän teân cöûa soå duy nhaát laø cac_tinh Map. Choïn OK ta
seõ thaáy cöûa soå Trình baøy ñöôïc môû ra (hình XI.2).

Teân cuûa cöûa soå naøy laø Layout. Cöûa
soå baûn ñoà ñöôïc choïn (cac_tinh) seõ
ñöôïc hieån thò trong moät khung coù
ñöôøng vieàn maëc ñònh maøu ñen, neùt
maûnh côõ 1. Beân traùi vaø beân treân cuûa
cöûa soå naøy coù hai thöôùc cho ta bieát kích
thöôùc cuûa trang trình baøy. Ñôn vò ño
kích thöôùc maëc ñònh treân hai thöôùc naøy
laø inch (1 inch = 2,54 cm). Ta coù theå
thay ñoåi ñôn vò naøy neáu muoán. Xem
caùch thay ñoåi ñôn vò cuûa MapInfo trong
Chöông I, muïc I.2.1. Kích thöôùc trình
baøy laø kích thöôùc trang giaáy maëc ñònh
cuûa maùy in. Tuyø theo thieát laäp maëc ñònh
cuûa maùy in caøi ñaët trong maùy tính cuûa
ta maø kích thöôùc trang trình baøy naøy seõ
khaùc nhau.

Treân trang trình baøy ta thaáy phaàn
noäi dung beân trong coù maøu traéng vaø
ñöôøng vieàn cuûa trang trình baøy coù maøu
xaùm nhaït. Phaàn xaùm nhaït ñoù laø phaàn leà
cuûa tôø giaáy. Neáu ta keùo phaàn noäi dung
cuûa caùc khung chôøm leân phaàn xaùm naøy
thì phaàn ñoù seõ khoâng ñöôïc in ra. Xem
theâm trong phaàn chænh trang in phía
döôùi.

Nhaép chuoät leân phaàn baûn ñoà treân cöûa soå Trình baøy, ta thaáy moät khung hieän leân vaø
phaàn beân trong cuûa khung ñoù ñöôïc ñaùnh daáu, boán goùc coù 4 ñieåm vuoâng maøu ñen.
Giöõ phím chuoät traùi treân caùc chaám vuoâng maøu ñen ñoù vaø reâ chuoät thì ta coù theå thay
ñoåi kích thöôùc cuûa khung hieän haønh. Ñoái vôùi cöûa soå baûn ñoà khi thay ñoåi kích thöôùc
cuûa khung hieän haønh thì baûn ñoà trong khung ñoù cuõng ñöôïc phoùng to thu nhoû theo.
Giöõ phím chuoät traùi ôû giöõa noäi dung khung vaø reâ chuoät thì coù theå di chuyeån khung.

Khi choïn leänh Window > New Layout Window neáu choïn One Frame for Window thì
chæ coù teân cuûa cöûa soå ñang ñöôïc kích hoaït, neáu choïn Frames for All Currently Open
Windows thì taát caû caùc cöûa soå ñang môû ñeàu ñöôïc ñöa vaøo (coù theå coù cöûa soå ta khoâng
caàn). Thoâng thöôøng khi trình baøy trang in trong cöûa soå Layout, ta coù theå caàn trình baøy

Hình XI.2. Cöûa soå Trình baøy vôùi moät
khung hieån thò cöûa soå baûn ñoà ñöôïc
choïn.
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nhieàu cöûa soå khaùc nhau (cöûa soå baûn ñoà, cöûa soå chuù giaûi, cöûa soå döõ lieäu, cöûa soå ñoà
thò,..). Do vaäy khi ñaõ taïo cöûa soå Layout roài ta coù theå theâm caùc cöûa soå khaùc vaøo cöûa soå
Layout baèng caùch söû duïng nuùt leänh veõ khung treân thanh coâng cuï Drawing. Xem
cuï theå caùch söû duïng nuùt leänh naøy trong phaàn ví duï ôû döôùi. Ta coù theå ñöa vaøo trong
caùc khung treân cöûa soå Layout caùc cöûa soå baûn ñoà, cöûa soå Browser, cöûa soå chuù giaûi, cöûa
soå ñoà thò, cöûa soå cöûa soå Info Tool, cöûa soå Statistics (thoáng keâ) vaø cöûa soå Message
(thoâng ñieäp).

Löu yù raèng ta coù theå in tröïc tieáp caùc cöûa soå baûn ñoà, cöûa soå Browser vaø cöûa soå bieåu
ñoà/ñoà thò baèng caùch kích hoaït cöûa soå caàn in roài choïn leänh File > Print töø menu chính.
Tuy nhieân ñoái vôùi caùc daïng cöûa soå coøn laïi chæ coù theå in ñöôïc khi ñöa chuùng vaøo cöûa
soå Layout.

Noäi dung treân caùc khung trong cöûa soå Layout coù tính chaát ñoäng,  nghóa laø neáu thay
ñoåi cöûa soå chính thì noäi dung trong khung seõ thay ñoåi töông öùng. Ví duï nhö neáu ñöa
vaøo khung moät cöûa soå baûn ñoà, sau ñoù kích hoaït laïi cöûa soå baûn ñoà ñoù roài phoùng to baûn
ñoà trong cöûa soå ñoù leân thì baûn ñoà treân khung trong cöûa soå Layout cuõng ñöôïc phoùng to
töông öùng.

XI.1.3. Menu Layout

Khi cöûa soå Trình baøy ñöôïc kích hoaït, treân menu chính xuaát hieän moät menu con nöõa
laø menu Layout. Menu naøy coù moät soá leänh cho pheùp chænh söûa caùc thuoäc tính cuûa cöûa
soå Trình baøy. Chuùng bao goàm caùc leänh sau:

- Change Zoom: ñieàu chænh tyû leä hieån thò cuûa trang trình baøy trong cöûa soå Layout. Ta
cuõng coù theå phoùng hay thu nhoû trang trình baøy treân cöûa soå Layout baèng hay nuùt
phoùng to-thu nhoû treân thanh coâng cuï Main.

- View Actual Size: Leänh naøy ñieàu chænh tyû leä trang trình baøy veà kích thöôùc thöïc (töùc
kích thöôùc baèng vôùi kích thöôùc luùc in ra).

- View Entire Layout: leänh naøy ñieàu chænh tyû leä cuûa cöûa soå Trình baøy sao cho toaøn boä
noäi dung ñöôïc hieån thò khít trong cöûa soå Trình baøy.

- Previous View: quay veà cöûa soå Trình baøy tröôùc ñoù.

- Bring to Front: trong moät cöûa soå Trình baøy coù nhieàu khung, khi nhaép chuoät choïn moät
khung naøo ñoù roài choïn leänh naøy thì khung ñoù seõ ñöôïc ñem leân treân caùc khung khaùc
(töùc che khuaát caùc khung khaùc).

- Send to Back: laø leänh ngöôïc laïi vôùi leänh treân, leänh naøy chuyeån moät khung ñöôïc choïn
ra phía sau caùc khung khaùc.

- Align Objects: leänh naøy cho pheùp ñieàu chænh vò trí töông ñoái cuûa khung ñöôïc choïn
so vôùi caùc khung khaùc hay so vôùi toaøn boä trang trình baøy. Leänh naøy ít khi ñöôïc söû
duïng.

- Create Drop Shadows: khi choïn moät khung roài choïn leänh naøy thì moät hoäp thoaïi seõ
hieän ra cho pheùp taïo boùng ñoå cho khung ñöôïc choïn (hình XI.3). Khai baùo khoaûng
caùch tính töø khung ñöôïc choïn theo chieàu ngang (oâ Horizontal) vaø theo chieàu ñöùng
(oâ Vertical) roài choïn OK thì boùng ñoå seõ ñöôïc taïo ra. Thöïc chaát leänh naøy veõ moät hình
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chöõ nhaät ngay döôùi khung ñöôïc
choïn vaø leäch ñi veà beân phaûi vaø
xuoáng döôùi moät khoaûng caùch
ñöôïc xaùc ñònh trong hai oâ
Horizontal vaø Vertical. Khi taïo
boùng ñoå xong maø di chuyeån
khung ñöôïc taïo boùng ñoå ñi thì
moät hình chöõ nhaät maøu ñen loä
ra.

- Options: khi choïn muïc naøy moät
hoäp thoaïi môû ra cho pheùp ñieàu
chænh moät soá thieát laäp trong cöûa soå Layout (hình XI.4). Hoäp thoaïi Layout Display
Options coù caùc noäi dung sau:

+ Show Ruler: ñaùnh daáu tuyø choïn naøy seõ hieån thò hai thöôùc ño ngang vaø doïc nhö
ñaõ trình baøy ôû phaàn treân.

+ Show Page Breaks: ñaùnh daáu tuyø choïn naøy seõ hieån thò ñöôøng chaám chaám phaân
caùch giöõa caùc trang Trình baøy (xem tieáp phaàn Layout Size beân döôùi).

+ Show Frame Contents: muïc naøy coù 3 tuyø choïn lieân quan ñeán vieäc hieån thò noäi
dung trong caùc khung cuûa cöûa soå trình baøy, bao goàm Always (luoân hieån thò noäi
dung), Only when Layout Window
is Active (chæ hieån thò noäi dung
khung khi cöûa soå Trình baøy ñöôïc
kích hoaït) vaø Never (khoâng hieån
thò noäi dung khung). Khi choïn
Never, phaàn khung chæ hieån thò
teân cuûa cöûa soå trong khung ñoù vaø
khung ñöôïc toâ maøu.

+ Layout Size: cho pheùp ñieàu kích
thöôùc cöûa soå trình baøy. Caùc oâ
Width vaø Height cho pheùp ta ñieàu
chænh soá trang hieån thò trong cöûa
soå Layout. Hai doøng phía döôùi
cho bieát kích thöôùc cuûa trang
giaáy hieän haønh cuõng nhö kích
thöôùc toång cuûa taát caû caùc trang
giaáy, trong tröôøng hôïp choïn hieån
thò nhieàu trang giaáy trong phaàn
Width vaø Height ôû treân. Thieát laäp
hieån thò soá trang naøy khaù thuaän
lôïi trong tröôøng hôïp khung baûn
ñoà maø ta muoán in lôùn hôn kích
thöôùc khoå giaáy coù trong maùy in
caøi ñaët treân maùy tính. Tröôøng hôïp
ñoù ta baät cheá ñoä hieån thò nhieàu
trang leân ñeå coù theå daøn trang baûn
ñoà treân nhieàu tôø giaáy.

Hình XI.4. Hoäp thoaïi Layout Display
Options - chænh caùc thieát laäp
hieån thò cuûa cöûa soå Trình baøy.

Hình XI.3. Hoäp thoaïi taïo boùng ñoå cho khung.
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+ AutoScroll: maëc ñònh tuyø choïn naøy ñöôïc baät leân. Khi ñöôïc choïn noù cho pheùp
cöûa soå Layout töï cuoän.

Ñeå hieåu roõ hôn cöûa soå Trình baøy, ta seõ xem xeùt moät ví duï döôùi ñaây.

XI.2. VÍ DUÏ

Giaû söû ta muoán trình baøy baûn ñoà 4 tænh cao nguyeân mieàn nam Trung Boä laø Laâm
Ñoàng, Ñaéc Laéc, Gia Lai, Kontum cuøng vôùi thoâng tin veà daân soá, dieän tích. Caùch thöïc
hieän nhö sau:

XI.2.1. Chuaån bò cöûa soå baûn ñoà

- Khôûi ñoäng MapInfo, môû baûng cac_tinh. Cöûa soå baûn ñoà coù teân cac_tinh Map môû ra.

- Ñieàu chænh kích thöôùc cöûa soå naøy sao cho noù khít vôùi hình daïng cuûa nöôùc ta. Ta
seõ duøng cöûa soå baûn ñoà naøy ñeå minh hoïa vò trí cuûa boán tænh naøy trong nöôùc ta ôû
phaàn sau.

- Töø menu chính choïn Map > Clone View. Moät cöûa soå thöù hai gioáng nhö cöûa soå ñaàu
ñöôïc taïo thaønh. Neáu ñeå yù thanh tieâu ñeà cuûa hai cöûa soå naøy ta seõ thaáy chuùng coù
hai teân gioáng nhau nhöng khaùc soá thöù töï laø cac_tinh Map: 1 vaø cac_tinh Map: 2.
Giaû söû ta seõ ñieàu chænh hieån thò boán tænh trong cöûa soå cac_tinh Map: 1. Nhaép chuoät
leân thanh tieâu ñeà cuûa cöûa soå baûn ñoà ñoù ñeå kích hoaït noù.

- Treân cöûa soå baûn ñoà cac_tinh Map: 1 duøng coâng cuï choïn ñeå choïn boán tænh Laâm
Ñoàng, Ñaéc Laéc, Gia Lai vaø Kontum.

- Töø menu chính choïn Query > Select. Hoäp thoaïi Select môû ra.

- Trong oâ Select Records from Table, choïn Selection, trong oâ Store Results in Table
ta thay chöõ Selection baèng chöõ “Bon_tinh_cao_nguyen” (Boán tænh cao nguyeân),
trong oâ Sort Results by Column ta choïn tröôøng ten. Xong choïn OK. Cöûa soå Browser
cuûa 4 tænh naøy ñöôïc môû ra vaø laø cöûa soå ñöôïc kích hoaït.

- Töø menu chính choïn Browse > Pick Fields ñeå môû hoäp thoaïi Pick Fields ra. Trong oâ
Columns in Browser beân phaûi ta choïn caùc tröôøng khoâng caàn thieát roài nhaán nuùt
Remove ñeå loaïi noù ra khoûi cöûa soå Browser, chæ ñeå laïi caùc tröôøng ten, dien_tich,
dan_so, chu_vi. Xong choïn OK.

- Töø menu chính choïn Options > Text Styles hay choïn nhanh nuùt chænh kieåu chöõ
treân thanh coâng cuï Drawing. Chænh kieåu chöõ trong cöûa soå Bon_tinh_cao_nguyen
Browser thaønh tieáng Vieät.

- Ñieàu chænh laïi kích thöôùc cöûa soå döõ lieäu cuûa boán tænh naøy sao cho vöøa ñuû hieån thò
toaøn boä döõ lieäu.

- Nhaép chuoät leân thanh tieâu ñeà cöûa soå baûn ñoà cac_tinh Map: 1 ñeå quay laïi ñieàu chænh
4 tænh treân cöûa soå baûn ñoà baûn ñoà naøy.

- Choïn nuùt phoùng to/thu nhoû cuõng nhö caùc nuùt coâng cuï ñieàu chænh cöûa soå baûn ñoà
khaùc treân thanh coâng cuï Main ñeå phoùng lôùn phaàn boán tænh naøy ra treân cöûa soå baûn
ñoà hieän taïi baèng caùch giöõ phím chuoät traùi vaø reâ chuoät töø goùc treân traùi cuûa 4 tænh
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naøy xuoáng goùc döôùi phaûi roài thaû chuoät ra. Boán tænh naøy ñöôïc phoùng to heát cöûa soå
baûn ñoà.

- Tinh chænh laïi cöûa soå naøy sao cho boán tænh chieám phaàn chính trong cöûa soå baûn ñoà.
Caùc tænh naøy laø noäi dung chính cuûa baûn ñoà vaø ñeå phaân bieät chuùng vôùi nhau treân
cöûa soå baûn ñoà, ta seõ tieán haønh toâ maøu cho 4 tænh naøy baèng leänh Create Thematic
Map.

XI.2.2. Toâ maøu cho baûn ñoà 

- Choïn nuùt coâng cuï choïn roài giöõ phím <Shift> vaø nhaép chuoät traùi leân caùc oâ vuoâng
beân traùi trong cöûa soå döõ lieäu Bon_tinh_cao_nguyen Browser ñeå choïn laïi boán tænh.

- Nhaép chuoät leân thanh tieâu ñeà ñeå kích hoaït laïi cöûa soå baûn ñoà cac_tinh Map: 1. Nhôù
ñöøng nhaép chuoät vaøo giöõa baûn ñoà vì noù seõ khöû choïn boán tænh ñang ñöôïc choïn. Neáu
lôõ khöû choïn 4 tænh treân thì ta phaûi duøng coâng cuï choïn ñeå choïn laïi boán tænh naøy treân
cöûa soå Browser hay coù theå choïn tröïc tieáp treân cöûa soå baûn ñoà.

- Töø menu chính choïn Map > Create Thematic Map. Hoäp thoaïi Create Thematic Map
- Step 1 of 3 môû ra.

- Trong coät Type ta choïn Individual, trong phaàn Template ta choïn Region IndValue
Default, xong choïn Next. Hoäp thoaïi Create Thematic Map - Step 2 of 3 môû ra.

- Trong oâ Table ta choïn Selection from cac_tinh (chæ laøm phaàn ñaõ ñöôïc choïn töø baûng
cac_tinh), trong oâ Field ta choïn tröôøng ten, xong choïn Next. Hoäp thoaïi Create
Thematic Map - Step 3 of 3 môû ra.

- Nhaép chuoät vaøo nuùt Legend ñeå môû hoäp thoaïi Customize Legend ra. Trong phaàn

Legend, ôû oâ Title söûa teân maëc ñònh laø cac_tinh by ten thaønh chöõ “Chuù giaûi” vaø

chænh kieåu chöõ veà tieáng Vieät cho ñuùng baèng nuùt chænh kieåu chöõ ôû döôùi oâ ñoù.

Trong phaàn Range Labels chænh kieåu chöõ cho chuù giaûi thaønh tieáng Vieät baèng nuùt

chænh kieåu chöõ. Taét choïn trong phaàn Show Record Count phía döôùi ñi. Nhaép chuoät

choïn nuùt Style ñeå chænh maøu cuûa 4 tænh treân sao cho öng yù. Xong choïn OK ñeå quay

laïi hoäp thoaïi Create Thematic Map - Step 3 of 3.

- Choïn OK trong hoäp thoaïi naøy ñeå hoaøn taát vieäc toâ maøu.

Ta thaáy 4 tænh naøy ñöôïc toâ maøu ñoàng thôøi moät cöûa soå nöõa ñöôïc taïo thaønh laø cöûa soå
coù teân Legend of cac_tinh Map: 1.

- Ñieàu chænh kích thöôùc cöûa soå naøy cho vöøa ñuû chöùa noäi dung chuù giaûi thoâi.

Cho ñeán böôùc naøy ta coù boán cöûa soå ñöôïc môû trong MapInfo laø cac_tinh Map: 1,
cac_tinh Map: 2, Bon_tinh_cao_nguyen Browser vaø Legend of cac_tinh Map: 1
(hình XI.5). Ta seõ theâm moät soá chi tieát nöõa vaøo cöûa soå baûn ñoà cac_tinh Map: 1 ñeå
laøm cho baûn ñoà ñaày ñuû hôn baèng caùch môû theâm moät soá lôùp baûn ñoà nöõa.

- Kích hoaït laïi cöûa soå baûn ñoà cac_tinh Map: 1 baèng caùch nhaép chuoät leân tieâu ñeà cöûa
soå cuûa noù.
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- Töø menu chính choïn File > Open Table. Hoäp thoaïi môû baûng hieän ra. Trong oâ
Preferred View ôû döôùi hoäp thoaïi naøy nhôù choïn Current Mapper.

- Vaøo thö muïc coù caùc baûng cuûa nöôùc Vieät Nam ta ñaõ taïo tröôùc ñoù, giöõ phím <Ctrl>
vaø nhaép chuoät choïn môû caùc baûng song, giao_thong vaø thanh_pho. Caùc baûng naøy
ñöôïc môû vaøo cöûa soå baûn ñoà cac_tinh Map: 1. Teân cöûa soå baûn ñoà naøy luùc naøy seõ
ñoåi thaønh thanh_pho, giao_thong,..., cac_tinh Map. Löu yù raèng luùc ñoù teân cöûa soå
baûn ñoà kia khoâng coøn soá 2 nöõa maø quay trôû laïi thaønh cac_tinh Map vì khoâng coøn
bò truøng teân nöõa.

- Töø menu chính choïn Map > Layer Control. Hoäp thoaïi Layer Control cuûa cöûa soå baûn
ñoà thanh_pho, giao_thong,..., cac_tinh Map môû ra.

Löu yù raèng khi môû hai cöûa soå baûn ñoà thì khi choïn leänh Layer Control, cöûa soå naøo
ñang ñöôïc kích hoaït thì hoäp thoaïi Layer Control cuûa cöûa soå baûn ñoà ñoù môû ra, vì
theá phaûi chuù yù.

- Nhaép chuoät choïn baûng thanh_pho roài choïn nuùt Display beân phaûi. Hoäp thoaïi
thanh_pho Display Options môû ra.

Hình XI.5.
Boán cöûa soå hieän
ñang ñöôïc môû
sau leänh taïo baûn
ñoà chuû ñeà kieåu
Individual cho 4
tænh.
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- Ñaùnh daáu choïn vaøo oâ Style Override vaø chænh kieåu bieåu töôïng cuûa caùc thaønh phoá
thaønh hình troøn maøu ñoû, côõ 10.

Laøm xong töøng lôùp nhaép chuoät choïn OK ñeå quay laïi hoäp thoaïi Layer Control.

XI.2.3. Daùn nhaõn cho baûn ñoà

- Daùn nhaõn teân caùc thaønh phoá: Choïn laïi lôùp thanh_pho. Ñaùnh daáu choïn vaøo oâ daùn
nhaõn töï ñoäng (bieåu töôïng hình caùi theû maøu vaøng) nhaép chuoät choïn nuùt Label ñeå
môû hoäp thoaïi thanh_pho Label Options ra.

- Trong oâ Label with choïn tröôøng ten; trong phaàn Styles cuûa hoäp thoaïi naøy nhaép chuoät
vaøo nuùt chænh kieåu chöõ ñeå ñònh daïng kieåu chöõ veà tieáng Vieät cho ñuùng - choïn ñaùnh

daáu choïn vaøo tuyø choïn Halo cuûa hoäp thoaïi
chænh kieåu chöõ, trong phaàn Label lines ñaùnh
daáu tuyø choïn None; ôû phaàn Position beân phaûi,
trong oâ Label Offset söûa giaù trò maëc ñònh laø 2
thaønh 4 points. Laøm xong choïn OK ñeå quay laïi
hoäp thoaïi Layer Control roài choïn OK laàn nöõa ñeå
ñoùng hoäp thoaïi Layer Control laïi.

Ta thaáy raèng cöûa soå baûn ñoà naøy ñaõ ñöôïc ñieàu
chænh vaø ñöôïc daùn nhaõn leân caùc thaønh phoá.

- Vì trong baûn ñoà naøy chuû ñeà chính boán tænh
cao nguyeân mieàn nam Trung boä neân ta coù theå
söû duïng coâng cuï choïn vaø giöõ phím <Shift> ñeå
choïn caùc nhaõn teân caùc thaønh phoá ôû nhöõng tænh
khaùc roài nhaán phím <Delete> ñeå xoaù chuùng ñi.
Keát quaû coù theå troâng gioáng nhö treân hình XI.6.

Tieáp theo ta seõ tieán haønh toâ maøu cho boán tænh
naøy treân cöûa soå baûn ñoà kia ñeå laøm noåi baät vò trí
boán tænh naøy treân baûn ñoà Vieät Nam.

- Kích hoaït cöûa soå baûn ñoà cac_tinh Map baèng
caùch nhaép chuoät vaøo thanh tieâu ñeà cuûa cöûa soå
ñoù. Neáu cöûa soå bò khuaát khoâng thaáy ñeå nhaép
chuoät ta coù theå kích hoaït noù baèng leänh Window
> choïn cöûa soå cac_tinh Map ôû döôùi.

- Choïn laïi boán tænh treân trong cöûa soå môùi kích
hoaït baèng coâng cuï choïn.

- Töø menu chính choïn Map > Create Thematic Map. Hoäp thoaïi Create Thematic Map
- Step 1 of 3 môû ra.

- Trong phaàn Type nhaép chuoät choïn kieåu Individual, trong oâ Template choïn Region
IndValue Default. Xong choïn Next. Hoäp thoaïi Create Thematic Map - Step 2 of 3
môû ra.

- Trong oâ Table ta vaãn choïn Selection from cac_tinh.

- ÔÛ trong phaàn Field choïn tröôøng ID. Trong phaàn naøy yù ñoà cuûa ta laø toâ maøu ñeå ñaùnh
daáu boán tænh cao nguyeân ñoù treân baûn ñoà Vieät Nam. Ta muoán 4 tænh ñoù coù cuøng

Hình XI.6. Cöûa soå baûn ñoà 4 tænh
ñöôïc theâm caùc lôùp khaùc, daùn
nhaõn vaø chænh kieåu baèng leänh
Style Override.
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maøu. Ta laïi bieát raèng leänh Create Thematic Map toâ maøu theo giaù trò döõ lieäu trong
tröôøng ñöôïc choïn, vì theá neáu ta choïn tröôøng naøo maø boán tænh naøy coù giaù trò gioáng
nhau thì MapInfo seõ toâ maøu boán tænh gioáng nhau. Trong tröôøng hôïp naøy, tröôøng ID
laø tröôøng ñöôïc taïo ra maëc ñònh trong quaù trình soá hoaù tröôùc ñaây vaø taát caû caùc giaù
trò trong tröôøng naøy ñeàu baèng 0. Vì theá neáu ta choïn tröôøng naøy thì 4 tænh ñöôïc choïn
seõ ñöôïc toâ maøu nhö nhau.

- Choïn Next. Hoäp thoaïi Create Thematic Map - Step 3 of 3 môû ra. Ta coù theå nhaán
nuùt Style ñeå ñoåi maøu neáu muoán. Trong tröôøng hôïp naøy chuù giaûi maøu caàn ñöôïc toâ
laø 4 tænh cao nguyeân neân haõy nhaép chuoät choïn nuùt Legend ñeå môû hoäp thoaïi
Customize Legend ra.

- Trong hoäp thoaïi Customize Legend, ôû phaàn Title, xoaù doøng chöõ cac_tinh by ID ñi vì
khoâng caàn thieát. ÔÛ phaàn Range Labels beân traùi, chænh kieåu chöõ veà tieáng Vieät cho
ñuùng baèng nuùt chænh kieåu chöõ.

- Nhaép chuoät vaøo giaù trò 0 (giaù trò cuûa tröôøng ID) trong oâ ôû döôùi phaàn Range Labels.
Söûa laïi laïi soá 0 trong oâ Edit selected range here thaønh “vò trí 4 tænh treân
Vieät Nam”; taét choïn trong phaàn Show Record Count ñi. Choïn OK ñeå quay laïi hoäp
thoaïi Create Thematic Map - Step 3 of 3 roài choïn OK tieáp ñeå keát thuùc leänh taïo baûn
ñoà chuû ñeà theo tröôøng ID cho 4 tænh treân.

Ta thaáy raèng caùc tænh treân ñaõ ñöôïc toâ maøu nhö nhau treân cöûa soå baûn ñoà cac_tinh
Map, ñoàng thôøi moät cöûa soå chuù giaûi thöù hai ñöôïc taïo thaønh coù teân laø Legend of
cac_tinh Map.

- Ñieàu chænh kích thöôùc cöûa soå chuù giaûi môùi naøy cho phuø hôïp.

XI.2.4. Chuyeån noäi dung leân cöûa soå Trình baøy

Luùc naøy ta seõ baét ñaàu tieán haønh ñöa caùc cöûa soå naøy vaøo cöûa soå Layout. Baûn ñoà
chính cuûa ta ôû ñaây laø baûn ñoà 4 tænh cao nguyeân, töùc laø cöûa soå baûn ñoà coù teân
thanh_pho, giao_thong,..., cac_tinh Map. Ta tieán haønh ñöa cöûa soå naøy vaøo cöûa soå
Trình baøy nhö sau:

- Kích hoaït laïi cöûa soå thanh_pho, giao_thong,..., cac_tinh Map.

- Kieåm tra laïi kích thöôùc cöûa soå cho phuø hôïp, sao cho 4 tænh treân chieám phaàn chính
trong cöûa soå naøy.

- Choïn Window > New Layout Window. Hoäp thoaïi New Layout Window môû ra.

- Giöõ nguyeân tuyø choïn maëc ñònh One Frame for Window vaø trong oâ beân traùi ta choïn
cöûa soå thanh_pho, giao_thong,..., cac_tinh Map.

- Choïn OK.

Ta thaáy cöûa soå Layout ñöôïc môû ra coù moät khung chöùa cöûa soå baûn ñoà ñöôïc choïn
ñoàng thôøi chuù giaûi cuûa cöûa soå baûn ñoà ñoù cuõng ñöôïc môû ra trong moät khung thöù hai
(hình XVI.7). Löu yù raèng cöûa soå baûn ñoà ñöôïc choïn seõ ñöôïc phoùng lôùn ra cho heát
trang giaáy maëc ñònh treân cöûa soå Trình baøy.

Ta caàn khoaûng khoâng gian treân trang trình baøy naøy ñeå goõ teân cuûa baûn ñoà sau naøy.
Vì vaäy ta caàn thu nhoû khung chöùa cöûa soå baûn ñoà môùi treân ñeå coù theâm khoaûng
khoâng gian treân trang trình baøy. Caùch laøm nhö sau:
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- Kích hoaït laïi cöûa soå Layout môùi taïo ra
(neáu caàn).

- Söû duïng coâng cuï choïn ñeå nhaép chuoät
ñuùp leân phaàn khung coù baûn ñoà 4 tænh
treân. Hoäp thoaïi Frame Object môû ra
(hình XI.8).

- ÔÛ oâ cuoái cuøng beân phaûi treân hoäp thoaïi
naøy coù muïc Scale in Paper vaø giaù trò tyû
leä coù daïng “1 cm = ...km”. Ñaây laø tyû
leä baûn ñoà treân trang trình baøy. Neáu taêng
con soá trong oâ naøy leân thì khung baûn ñoà
töông öùng seõ thu nhoû laïi. Giaû söû ta
chænh tyû leä naøy thaønh “1 cm = 25 km“
(töùc tyû leä baûn ñoà laø 1:250.000) roài choïn
OK. Ta caàn nhôù tyû leä naøy ñeå sau naøy goõ
vaøo tieâu ñeà baûn ñoà.

Khung chöùa cöûa soå baûn ñoà 4 tænh ñöôïc
thu nhoû laïi.

- Nhaép chuoät leân giöõa khung baûn ñoà môùi
ñieàu chænh tyû leä xong vaø giöõ chuoät traùi
roài reâ chuoät ñeå keùo khung baûn ñoà ñoù
vaøo giöõa trang trình baøy, nhôù chöøa
khoaûng troáng treân ñaàu trang trình baøy
ñeå goõ teân baûn ñoà sau naøy.

- Nhaép chuoät leân khung chuù giaûi roài keùo noù veà goùc döôùi beân phaûi cuûa khung baûn ñoà.
Tieáp theo ta seõ tieán haønh theâm cöûa soå baûn ñoà Vieät Nam cuøng vôùi vò trí 4 tænh treân
ñaõ ñöôïc ñaùnh daáu.

- Nhaép chuoät choïn coâng cuï veõ khung treân thanh coâng cuï Drawing (laø nuùt coâng cuï
hình vuoâng vieàn vaøng). Löu yù raèng nuùt coâng cuï naøy chæ söû duïng ñöôïc khi cöûa soå
Layout ñöôïc kích hoaït.

- Di chuyeån con troû chuoät trôû laïi cöûa soå Layout, con troû chuoät bieán thaønh hình daáu
coäng. Giöõ phím chuoät traùi vaø reâ chuoät ñeå taïo thaønh moät hình chöõ nhaät treân trang
trình baøy ôû vò trí naøo cuõng ñöôïc. Khi thaû chuoät ra, hoäp thoaïi Frame Object seõ “nhaûy”
ra.

- ÔÛ oâ Window treân cuøng ta choïn cöûa soå baûn ñoà cuûa nöôùc Vieät Nam coù teân laø cac_tinh
Map. Xong choïn OK. Khung môùi ñöôïc veõ seõ coù cöûa soå baûn ñoà nöôùc Vieät Nam vôùi
4 tænh treân ñöôïc ñaùnh daáu.

- Nhaép chuoät leân choïn khung môùi taïo thaønh ñeå laøm xuaát hieän 4 ñieåm khoáng cheá
khung. Giöõ chuoät traùi treân caùc ñieåm khoáng cheá roài reâ chuoät ñeå ñieàu chænh kích
thöôùc khung sao cho noù hieån thò ñöôïc toaøn boä nöôùc Vieät Nam. Nhaép chuoät ñuùp leân
khung naøy ñeå ñieàu chænh tyû leä laïi sao cho noù chæ chieám khoaûng 1/4 goùc treân phaûi
cuûa khung baûn ñoà kia. Giöõ chuoät traùi ôû giöõa khung naøy vaø keùo noù veà saùt goùc treân
phaûi cuûa khung baûn ñoà kia.

- Söû duïng leänh veõ khung töông töï nhö treân ñeå cheøn caùc cöûa soå chuù giaûi cuûa cöûa soå

Hình XI.7. Cöûa soå baûn ñoà ñöôïc choïn
cuøng chuù giaûi cuûa noù ñöôïc môû
ra treân hai khung trong cöûa soå
Trình baøy.
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cac_tinh Map (coù teân laø Legend of cac_tinh Map) cuõng nhö cöûa soå baûng döõ lieäu cuûa
boán tænh treân (töùc cöûa soå Bon_tinh_cao_nguyen Broswer), ñieàu chænh kích thöôùc
cuûa chuùng vaø di chuyeån chuùng ñeán caùc vò trí thích hôïp.

- Goõ tieâu ñeà cuûa baûn ñoà: kích hoaït laïi cöûa soå Layout neáu caàn. Nhaép chuoät choïn coâng
cuï ñaùnh kyù töï vaø nhaép chuoät leân cöûa soå tieâu ñeà vaø goõ teân tieâu ñeà cuûa baûn ñoà, ví

duï nhö “Baûn ñoà boán tænh cao nguyeân nam Trung boä”. Sau khi goõ teân
baûn ñoà xong, duøng coâng cuï choïn ñeå choïn laïi teân baûn ñoà ñoù roài choïn nuùt chænh kieåu
chöõ ñeå chænh laïi cho phuø hôïp. Ta cuõng coù theå duøng coâng cuï choïn nhaép chuoät leân
thanh tieâu ñeà giöõ phím chuoät traùi vaø reâ chuoät ñeå di chuyeån tieâu ñeà baûn ñoà neáu
muoán. Keát quaû cuoái cuøng coù theå troâng gioáng nhö treân hình XI.9.

- Ñeå löu laïi keát quaû trình baøy naøy, töø menu chính choïn File > Save Workspace, choïn
thö muïc löu taäp tin workspace vaø ñaët teân cho phieân laøm vieäc roài nhaán nuùt Save.
Laàn sau ta chæ caàn môû taäp tin workspace ra baèng leänh File > Open workspace vaø
choïn laïi taäp tin ñaõ ñöôïc löu thì toaøn boä seõ ñöôïc môû ra laïi nhö cuõ ñeå saün saøng cho
vieäc in aán neáu caàn.

Hình XI.8. Hoäp thoaïi Frame Object ñeå chænh tyû leä baûn ñoà trong khung.
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Hình XI.9. Cöûa soå Trình baøy sau cuøng.
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XI.3. TYÛ LEÄ BAÛN ÑOÀ TREÂN CÖÛA SOÅ BAÛN ÑOÀ VAØ 
TYÛ LEÄ BAÛN ÑOÀ TREÂN TRANG TRÌNH BAØY

XI.3.1. Tyû leä baûn ñoà treân cöûa soå baûn ñoà

Thoâng thöôøng ta chæ quan taâm ñeán tyû leä baûn ñoà
treân trang trình baøy vì ñoù laø tyû leä baûn ñoà luùc in aán.
Tyû leä baûn ñoà treân trang trình baøy hoaøn toaøn khaùc vôùi
tyû leä baûn ñoà treân cöûa soå baûn ñoà.

Khi môû caùc lôùp baûn ñoà ra trong MapInfo, thoâng
tin veà tyû leä baûn ñoà coù theå ñöôïc thaáy treân thanh traïng
thaùi cuûa maøn hình MapInfo. Khi moät cöûa soå baûn ñoà
ñöôïc kích hoaït, goùc traùi cuûa thanh traïng thaùi coù moät
oâ hieån thò chöõ Zoom vaø moät soá ño khoaûng caùch. Soá
ño khoaûng caùch ñoù cho ta bieát kích thöôùc theo chieàu
ngang cuûa cöûa soå baûn ñoà laø bao nhieâu. Khi ta
phoùng to hay thu nhoû baûn ñoà baèng nuùt coâng cuï
phoùng to/thu nhoû thì soá ño trong oâ Zoom naøy cuõng
thay ñoåi theo töông öùng. Di chuyeån con troû chuoät
vaøo giöõa oâ naøy con troû chuoät bieán thaønh hình baøn
tay coù ngoùn troû chæ leân. Nhaép chuoät treân oâ Zoom seõ
môû ra moät menu nhoû cho pheùp ta choïn cheá ñoä hieån
thò trong oâ naøy vôùi 3 tuyø choïn (hình XI.10) laø:

- Zoom (Window Width): hieån thò chieàu roäng cuûa
cöûa soå baûn ñoà hieän haønh (laø tuyø choïn maëc ñònh).

- Map Scale: hieån thò tyû leä cuûa baûn ñoà.

- Cursor Location: toaï ñoä cuûa con troû chuoät khi di
chuyeån chuoät treân cöûa soå baûn ñoà. Thoâng tin toaï
ñoä naøy coù theå laø kinh ñoä/vó ñoä hay laø ñôn vò khaùc
tuyø thuoäc vaøo heä quy chieáu cuûa baûn ñoà ñang
ñöôïc môû treân cöûa soå.

Trong quaù trình laøm vieäc treân cöûa soå baûn ñoà ta
coù theå muoán phoùng to hay thu nhoû baûn ñoà. Hai nuùt
coâng cuï phoùng to/thu nhoû treân thanh coâng cuï Main
cho pheùp ta phoùng to thu nhoû baûn ñoà baèng caùch nhaép chuoät treân baûn ñoà. Moãi laàn nhaép
chuoät seõ phoùng to baûn ñoà ra gaáp ñoâi hay thu nhoû laïi moät nöûa. Neáu muoán ñieàu chænh
baûn ñoà ñeán moät tyû leä nhaát ñònh naøo ñoù theo yù muoán thì ta phaûi söû duïng leänh Change
View. Caùch laøm nhö sau:

- Kích hoaït cöûa soå baûn ñoà muoán thay ñoåi tyû leä baèng caùch nhaép chuoät leân thanh tieâu
ñeà cuûa cöûa soå ñoù hay choïn noù töø menu Window.

- Töø menu chính choïn Map > Change View. Hoäp thoaïi Change View môû ra (hình
XI.11). Hoäp thoaïi naøy bao goàm caùc noäi dung nhö sau:
+ Zoom (Window Width): oâ naøy cho bieát kích thöôùc ngang cuûa cöûa soå baûn ñoà.
+ Map Scale: cho bieát tyû leä cuûa baûn ñoà treân cöûa soå hieän haønh.

Hình XI.10. Caùc tuyø choïn treân
oâ Zoom maëc ñònh treân
thanh Traïng thaùi (Status
Bar) cuûa maøn hình
MapInfo.
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+ Center of Window: cho bieát toaï ñoä ñieåm giöõa cuûa cöûa soå baûn ñoà.

Taát caû nhöõng thoâng soá
naøy ñeàu coù theå thay ñoåi ñeå
ñieàu chænh cöûa soå baûn ñoà.
Neáu ta muoán thay ñoåi tyû leä
baûn ñoà ñeán moät tyû leä xaùc
ñònh thì ta seõ goõ giaù trò vaøo oâ
Map Scale. Ví duï nhö trong
hình XI.11, tyû leä baûn ñoà
ñang laø 1 cm = 250.7 km
(töùc tyû leä baûn ñoà laø 1:
2.507.000 - moät phaàn hai
trieäu naêm traêm leû baûy
nghìn). Neáu ta muoán thay
ñoåi baûn ñoà thaønh tyû leä moät
phaàn trieäu thì ta seõ goõ con soá 100 vaøo oâ treân, töùc laø 1 cm = 100 km.

XI.3.2. Tyû leä baûn ñoà treân cöûa soå Trình baøy

Tyû leä baûn ñoà treân cöûa soå baûn ñoà chæ nhaèm phuïc vuï cho vieäc phoùng to thu nhoû baûn
ñoà trong quaù trình chænh söûa, xem xeùt boá cuïc, kieåm tra vò trí nhaõn,...Trong khi ñoù moät
trong nhöõng öùng duïng chính cuûa chuùng ta laø in baûn ñoà ra sau khi trình baøy xong. Vaø
nhö ta ñaõ bieát, baûn ñoà chuû yeáu ñöôïc in ra töø cöûa soå Trình baøy. Tyû leä baûn ñoà trong cöûa
soå Trình baøy ñöôïc xöû lyù moät caùch khaùc.

Giaû söû neáu ta kích hoaït moät cöûa soå baûn ñoà roài duøng leänh Window > New Layout
Window ñeå ñöa noù vaøo cöûa soå trình baøy thì MapInfo seõ ñöa cöûa soå baûn ñoà ñoù vaøo moät
khung vaø töï ñoäng ñieàu chænh khung ñoù sao cho noù chieám heát trang giaáy maëc ñònh cuûa
maùy in ñöôïc caøi ñaët treân maùy tính (hoaëc maùy in maëc ñònh duøng cho MapInfo trong
tröôøng hôïp coù caøi ñaët nhieàu maùy in). Do thieát laäp nhö vaäy neân khi chuyeån cöûa soå baûn
ñoà töø moät tyû leä ñaõ bieát
naøo ñoù sang moät khung
trong cöûa soå trình baøy thì
tyû leä baûn ñoà trong khung
töï ñoäng bò thay ñoåi sao
cho chieám heát trang giaáy
vaø tyû leä naøy chaéc chaén seõ
khaùc vôùi tyû leä treân cöûa soå
baûn ñoà.

Muoán bieát tyû leä baûn
ñoà treân cöûa soå trình baøy
(töùc laø tyû leä luùc in ra),
nhaép chuoät ñuùp vaøo
khung chöùa baûn ñoà. Hoäp
thoaïi môû ra (hình XI.12)
cho bieát nhöõng thoâng tin
sau:

- Window: oâ naøy cho bieát
Hình XI.12. Hoäp thoaïi Frame Object - chænh tyû leä

baûn ñoà treân cöûa soå Trình baøy.

Hình XI.11. Hoäp thoaïi Change View - 
thay ñoåi tyû leä baûn ñoà vaø khung nhìn.
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cöûa soå baûn ñoà naøo ñang ñöôïc ñaët trong khung ñöôïc choïn. Ta coù theå thay ñoåi cöûa
soå ñaët trong khung neáu muoán, tuy nhieân chænh söûa naøy thöôøng laø khoâng caàn thieát.

- Caùc oâ Bound X1, Y1; X2, Y2 cho ta bieát vò trò caùc goùc cuûa khung ñoù treân trang giaáy.

- Caùc oâ Width vaø Height cho ta bieát kích thöôùc khoå giaáy hieän haønh.

- Fill Frame with Contents: maëc ñònh ñöôïc ñaùnh daáu, neáu taét tuyø choïn naøy thì khung
ñöôïc choïn chæ laø khung roãng, khoâng chöùa cöûa soå naøo caû.

- Scale on Paper: oâ naøy cho bieát tyû leä baûn ñoà treân giaáy. Ñaây chính laø tyû leä luùc in ra.

Muoán thay ñoåi tyû leä baûn ñoà khi in ra, ta cuõng goõ tyû leä ta muoán vaøo oâ Scale on
Paper. Ví duï neáu muoán baûn ñoà in ra coù tyû leä laø moät phaàn naêm möôi nghìn (1:50.000)
ta seõ goõ 1 cm = 0.5 km.

Löu yù raèng neáu in baûn ñoà thì tyû leä treân trang Trình baøy môùi laø tyû leä baûn ñoà luùc in
ra. Ñieàu chænh tyû leä treân cöûa soå baûn ñoà, nhö ñaõ noùi, chæ nhaèm muïc ñích nhìn thaáy roõ
caùc noäi dung ñeå saép xeáp caùc lôùp baûn ñoà vaø trình baøy cho ñeïp vaø hôïp lyù maø thoâi.

XI.4. MOÄT SOÁ THIEÁT LAÄP CUÕNG NHÖ CAÙC LEÄNH 
THÖÔØNG HAY SÖÛ DUÏNG TRONG CÖÛA SOÅ TRÌNH BAØY

- Chænh thieát laäp khung: moãi cöûa soå khi ñöôïc trình baøy treân cöûa soå Layout ñöôïc ñaët
trong moät khung. Khi nhaép chuoät leân moät khung roài choïn nuùt coâng cuï chænh vuøng

treân thanh coâng cuï Drawing thì hoäp thoaïi Region Style môû ra cho pheùp chænh
khung ñöôïc choïn gioáng nhö moät chænh moät vaät theå kieåu vuøng bình thöôøng. Ví duï
ta coù theå vaøo phaàn Border ñeå boû ñöôøng vieàn khung hoaëc coù theå thay ñoåi ñöôøng
vieàn maëc ñònh cuûa khung. Phaàn Fill cho pheùp ta chænh maøu neàn cuûa khung ñoù.

- Khi chænh vò trí cuûa caùc khung trong cöûa soå Layout xong roài, neáu muoán di chuyeån
moät soá khung ñi nhöng laïi khoâng laøm thay ñoåi vò trí töông ñoái cuûa chuùng vôùi nhau,
ta coù theå giöõ phím <Shift> roài duøng coâng cuï choïn ñeå choïn chuùng, giöõ phím chuoät
traùi vaø di chuyeån chuoät, cuõng coù theå choïn taát caû caùc thaønh phaàn trong cöûa soå
Layout baèng leänh  Query > Select All, giöõ phím chuoät traùi treân moät khung naøo ñoù
vaø reâ chuoät thì coù theå di chuyeån toaøn boä caùc thaønh phaàn.

- Khi cöûa soå Layout ñang ñöôïc kích hoaït, ta coù theå söû duïng caùc nuùt coâng cuï veõ ñieåm,
ñöôøng, vuøng cuõng nhö goõ chöõ ñeå theâm caùc noäi dung caàn thieát vaøo cöûa soå naøy.

- Coù theå ñònh daïng trang in cho cöûa soå Trình baøy baèng leänh  File > Page Setup. Khi
ñoù hoäp thoaïi Page Setup seõ môû ra (hình XI.13) vaø bao goàm caùc noäi dung sau:

+ Phaàn Paper coù hai oâ laø Size cho pheùp choïn khoå giaáy vaø Source cho pheùp choïn
cheá ñoä aên giaáy khi in.

+ Phaàn Orientation coù hai tuyø choïn Portrait (ñònh daïng giaáy ñöùng) vaø Landscape
(ñònh daïng giaáy naèm ngang).

+ Phaàn Margins duøng ñeå ñònh daïng leà tôø giaáy, theo maëc ñònh taát caû caùc caïnh tôø
giaáy laø Left (leà traùi), Right (leà phaûi), Top (leà treân) vaø Bottom (leà döôùi) ñeàu baèng
khoâng (töùc laø in khoâng chöøa leà). Thay ñoåi leà giaáy baèng caùch naïp thoâng soá vaøo
boán oâ treân. Ñôn vò maëc ñònh khi caøi ñaët MapInfo trong 4 oâ naøy laø inch, coù theå
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ñieàu chænh laïi thaønh centimet. Xem ñieàu chænh ñôn vò trong Chöông I, muïc I.2.1.

+ ÔÛ döôùi hoäp thoaïi Page Setup coù nuùt Printer. Nuùt naøy môû ra hoäp thoaïi cho pheùp
choïn maùy in trong oâ Name (neáu ta caøi nhieàu maùy in), ñieàu chænh moät soá thieát
laäp cuûa maùy in cuõng nhö xem tình traïng maùy in,...

- Khi ñaõ ñieàu chænh vaø
hoaøn taát cöûa soå Trình
baøy roài nhöng ta coù theå
muoán löu cöûa soå Trình
baøy thaønh moät taäp tin
hình aûnh (chaúng haïn ñeå
söû duïng trong caùc phaàn
meàm khaùc sau naøy).
Nhu caàu naøy coù theå thöïc
hieän ñöôïc baèng caùch:
+ kích hoaït cöûa soå

Layout.
+ töø menu chính choïn

File > Save Window
As. Khi choïn leänh
naøy moät hoäp thoaïi
môû ra (hình XI.14).
Hoäp thoaïi naøy coù caùc tuyø choïn:

* Same as Window: löu cöûa soå Layout ñöôïc choïn ñuùng vôùi kích thöôùc treân cöûa soå. 

* Custom Size: ñieàu chænh kích thöôùc taäp tin aûnh theo yù muoán.

* Nuùt Advanced: cho pheùp ñieàu chænh moät soá thieát laäp khi xuaát cöûa soå ra taäp tin aûnh.
+ Choïn xong nhaép chuoät vaøo nuùt Save thì hoäp thoaïi Save Window to File môû ra.
+ Trong oâ Save in choïn thö muïc ñeå löu taäp tin aûnh, ñaët teân taäp tin aûnh trong oâ

File name. OÂ Save as Type cho pheùp choïn ñònh daïng aûnh ñeå löu.
+ Choïn xong caùc thieát laäp treân roài nhaán nuùt Save thì ta seõ coù moät taäp tin aûnh cuûa

cöûa soå Layout.
- Coù theå môû nhieàu cöûa soå

Trình baøy vaø taïo nhieàu trang
trình baøy trong moät phieân
laøm vieäc treân MapInfo. Khi
taïo nhieàu cöûa soå Layout thì
tieâu ñeà cöûa soå Layout ñöôïc
ñaùnh soá ñeå deã phaân bieät, ví
duï nhö Layout:1, Layout: 2,...

Hình XI.13. Hoäp thoaïi Page Setup.

Hình XI.14. Hoäp thoaïi Save Window As cho pheùp
löu moät cöûa soå thaønh moät taäp tin aûnh.
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